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MS WORD WINDOWS ELEMENTS

WORD WINDOW
MENU BAR

TITLE BAR

ADDITIONAL TOOL BAR

TOOL BAR
FORMATIG BAR

V. BAR

V.RULLER

BROWSING
WINDOW

VIEW BUTTON STATUS BAR

H. BAR

Create a new blank document
1. On the File menu, click New.
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2. Click the General tab, and then double-click the Blank Document icon.

1.Save a new, unnamed document
1. Click Save

on the Standard toolbar.

2. If you want to save the document in a different folder, locate and open the folder.
3. In the File name box, type a name for the document.
You can use long, descriptive file names if you want.
4. Click Save. It saves the document at c:\desktop\My Documents\.

2. Open a document as a copy
1. Click Open

.
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2. If you want to open a document that was saved in a different folder, locate and
open the folder.
3. Click the document you want to open a copy of.
If you can't find the document in the folder list, you can search for it.
4. Click the arrow next to the Open button, and then click Open as Copy.

Menu Bars
File Menu
Edit Menu

View Menu, Insert Menu, Format menu, Tools Menu, Table Menu, Window Menu, and
Help.
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File Menu:
In this menu we can create a new document, open an existing document and you can
close the document. We can save the document with separate name, separate format
also. We can change the page setup, preview the page and can the print. We can exit
from ms word.

Edit menu:
In this menu we can cut, copy, paste, paste special, undo, select all and find the text,
and replace the text, as we required.

View menu:
In this menu different we observe the different views like normal view, web layout
view, print layout view, out line view. And we can observe ruler, toolbars, header and
footer etc.

Insert Menu:
In this menu we can insert breaks, page numbers, date and time, auto text, symbols,
comments, footnotes, caption, comment, pictures and hyperlinks etc.

Format menu:
In this menu we can format the text font, size and color. We can insert the bullets and
numbering and we can modify the background color, we can make page attractively
with different borders.

Tools Menu:
In this menu we can check the document spelling and grammar. We can create
Envelops and labels. We can customize the tools bars, commands and options.
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Table Menu:
In this menu we can draw the tables, insert the tables, rows, and columns. And we can
merge the tables, sort the data and we can format the tables, rows and columns.

Window:
In this menu we can arrange the document windows as required

Help Menu:
In this menu you can get the information about the ms word.

Tool Bars:
The Toolbars are Standard Tool bar, Formatting Tool Bar, Auto Text, Clip Board,
Control Tool Box, Database, Drawing, Farms, Frames, Picture, Reviewing, Table and
Boarders, Visual Basic, Web, Web Tools and Word art. And you can customize the
additional tool bar.
FORMATTING THE TEXT
From Format menu you can select the text font, size, style and color. You can
edit the typed text paragraph, as you like. We can give the boarder for text and page
also. We can divide the page as required columns. Here we can change the
background of the page also. We can change the text case as required.

Overview of page margins
What are page margins?
Page margins are the blank space around the edges of the page. In general, you insert
text and graphics in the printable area inside the margins. However, you can position
some items in the margins — for example, headers, footers, and page numbers.
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Return to

Ways to set page margins:
Word offers several page margin options. You can:
Use the default page margins or specify your own Change the page margins
Set margins for facing pages Use mirror margins to set up facing pages for doublesided documents, such as books or magazines. In this case, the margins of the left
page are a mirror image of those of the right page (that is, the inside margins are the
same width, and the outside margins are the same width).
Add a margin for binding Use a gutter margin to add extra space to the side or top
margin of a document you plan to bind. A gutter margin ensures that the binding
doesn’t obscure text.
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Select text and graphics by using the mouse
To select

Do this

Any amount of text

Drag over the text.

A word

Double-click the word.

A graphic

Click the graphic.

A line of text

Move the pointer to the left of the line until it
changes to a right-pointing arrow, and then click.

Multiple lines of text

Move the pointer to the left of the lines until it
changes to a right-pointing arrow, and then drag
up or down.

A sentence

Hold down CTRL, and then click anywhere in the
sentence.

A paragraph

Move the pointer to the left of the paragraph until
it changes to a right-pointing arrow, and then
double-click. Or triple-click anywhere in the
paragraph.

Multiple paragraphs

Move the pointer to the left of the paragraphs until
it changes to a right-pointing arrow, and then
double-click and drag up or down.

A large block of text

Click at the start of the selection, scroll to the end
of the selection, and then hold down SHIFT and
click.

An entire document

Move the pointer to the left of any document text
until it changes to a right-pointing arrow, and then
triple-click.
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Select text and graphics
Select text by holding down SHIFT and pressing the key that moves the insertion point.
Press

To extend a selection

SHIFT+RIGHT ARROW

One character to the right

SHIFT+LEFT ARROW

One character to the left

CTRL+SHIFT+RIGHT ARROW

To the end of a word

CTRL+SHIFT+LEFT ARROW

To the beginning of a word

SHIFT+END

To the end of a line

SHIFT+HOME

To the beginning of a line

SHIFT+DOWN ARROW

One line down

SHIFT+UP ARROW

One line up

CTRL+SHIFT+DOWN ARROW

To the end of a paragraph

CTRL+SHIFT+UP ARROW

To the beginning of a paragraph

SHIFT+PAGE DOWN

One screen down

SHIFT+PAGE UP

One screen up

CTRL+SHIFT+HOME

To the beginning of a document

CTRL+SHIFT+END

To the end of a document

ALT+CTRL+SHIFT+PAGE DOWN To the end of a window
CTRL+A

To include the entire document
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Insert a WordArt drawing object
1. On the Drawing toolbar, click Insert WordArt

.

2. Click the type of WordArt drawing object you want, and then click OK.
3. In the Edit WordArt Text dialog box, type the text you want to format, select any
other options you want, and then click OK.
4. To add or change effects to the text, use the buttons on the WordArt and
Drawing toolbars. The WordArt toolbar appears when you click the WordArt
special text.

Change the font of text or numbers
1. Select the text you want to change.
2. On the Formatting toolbar, click a font name in the Font box

.

About formatting text by using styles
What is a style?
A style is sets of formatting characteristics that you can apply to text in your document
to quickly change its appearance. When you apply a style, you apply a whole group of
formats in one simple task. For example, you may want to format the title of a report to
make it stand out. Instead of taking three separate steps to format your title as 16 pt,
Arial, and center-aligned, you can achieve the same result in one step by applying the
Title style.
When you start Microsoft Word, the new blank document is based on the Normal
template, and text that you type uses the Normal style. This means that when you start
typing, Word uses the font, font size, line spacing, text alignment, and other formats
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currently defined for the Normal style. The Normal style is the base style for the Normal
template, meaning that it’s a building block for other styles in the template.
There are a number of other styles besides Normal available in the Normal template. A
few basic ones are shown in the Style list

on the Formatting toolbar. You can

preview and select others in the Style dialog box (Format menu, Style command).

What are paragraph and character styles?
A paragraph style controls all aspects of a paragraph's appearance, such as text
alignment, tab stops, line spacing, and borders, and can include character formatting. If
you want a paragraph to have a particular combination of attributes that aren’t in an
existing style (for example, a bold, italic, center-aligned heading in the Arial Narrow
font), you can create a new paragraph style.
A character style affects selected text within a paragraph, such as the font and size of
text, and bold and italic formats. Characters within a paragraph can have their own
style even if a paragraph style is applied to the paragraph as a whole. If you want to be
able to give certain types of words or phrase the same kind of formatting, and the
formatting isn’t in an existing style, you can create a new character style.

Apply a different style to text
When you want to change the style of text, you can apply an existing style, also known
as a built-in style. If you don’t see a style with the characteristics you want, you can
create a new style, and then apply it.

Modify a style
To quickly change all the text that is formatted with a particular style, you can redefine
the style. For example, if your main headings are 14 pt Arial, flush left, and bold, and
you later decide you want your headings to be 16 pt, Arial Narrow, and centered, you
don't have to reformat every main heading in your document. Instead, just change the
properties of that style. Modify a style
Note that when you change a formatting element of the base style in a document, all
styles that originate from the base style in that document will also reflect the change.
You can also have Word modify a style automatically, meaning that Word detects when
you alter the formatting of text containing a style, and then automatically updates the
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style. When Word automatically updates the style, all text formatted with that style is
updated to match the formatting of the text you just changed. Have Word automatically
update a style

Preview and apply different styles by using the Style Gallery
You can use the Style Gallery to see how your entire document would look if you
applied styles from a different template. If you want, you can then apply the styles
directly from the Style Gallery. When you select a template in the Style Gallery dialog
box (Format menu, Theme command, Style Gallery button), a preview window shows
how your document would look. You can also view sample documents showing styles
from the selected template, or see a list of the styles used in the template. View or
apply the styles from another template by using the Style Gallery

Ways to check spelling and grammar
Microsoft Word provides several ways to check spelling and grammar:
Automatically correct spelling and grammar To fix spelling and grammatical errors
without having to confirm each correction use the AutoCorrect feature. For example, if
you type definitely and then type a space or other punctuation, AutoCorrect replaces it
with "definitely." AutoCorrect can make corrections that are generated by the spelling
checker's main dictionary, and by a list of built-in AutoCorrect entries. You can easily
add your own AutoCorrect entries or remove unwanted ones.
Automatically check spelling and grammar as you type To check for spelling and
grammatical errors "behind the scenes," use automatic spelling and grammar checking.
As you type, the spelling and grammar checkers check the text, and then mark possible
errors with wavy underlines. To correct an error, display a shortcut menu and select the
correction you want. If you find the wavy underlines distracting, you can temporarily
hide the underlines until you're ready to make corrections.
Check spelling and grammar all at once You can check for spelling and grammatical
errors, and then confirm each correction. This method is useful if you want to postpone
proofing a document until after you finish editing it.
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Check the spelling and grammar of text in another language To check text in another
language, you need to install the spelling and grammar tools for that language, and
make sure the language is enabled for editing. Thereafter, Word automatically detects
the language in your documents, and uses the correct spelling and grammar tools.

Creating tables:
Creating new tables You can quickly create a simple table by using the Insert Table
command, or you can use the Draw Table tool to quickly create a more complex
table — for example, one that contains cells of different heights or a varying number of
columns per row. Using Draw Table is similar to drawing a rectangle on graph paper —
first, draw a line from one corner of the table to the corner diagonally opposite in order
to define the boundary of the entire table, and then draw the column and row lines
inside.
Creating tables inside other tables You can also use Draw Table to create tables
inside other tables, or nested tables. Nested tables are particularly useful when you use
a table to lay out a page and then want to use a table to present information — for
example, if you use a table to lay out the Web page for your company's sales
department, you might want to insert in the layout a nested table illustrating the
department's quarterly earnings.
Creating tables from existing information You can convert existing paragraphs of text
to a table. You can also create a table from an existing data source, such as a
database or worksheet.

Formatting Tables:
You can enhance your table by adding borders and filling cells with colors, patterns, or
shading. You can also use the Table AutoFormat command to quickly give your table a
polished design. Changing the position of text in a table
Changing the orientation of text By default, Microsoft Word aligns text horizontally in
table cells, callouts, text boxes, or AutoShapes. You can change the text orientation so
that the text is displayed vertically.
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Changing the alignment of text in a table cell By default, Word aligns text in a table to
the upper left of a cell. You can change the alignment of text in a cell — both the
vertical alignment (top, center, or bottom) and the horizontal alignment (left, center, or
right).

Working with long Tables
When you work with a very long table, it must be divided wherever a page break
occurs. You can make adjustments to the table to make sure that the information
appears, as you want it to when the table spans multiple pages.
Repeat headings on every page: If your table has a heading, you can make the
heading automatically appear at the top of each page.
Control where the table is divided: By default, if a page break occurs within a large row,
Word allows a page break to divide the row between the two pages. You can prevent a
table row from breaking across pages. You can also force the table to break across
pages at a particular place.

Using tables as spreadsheets
You can use tables to perform some of the tasks you might use a spreadsheet for —
for example, you can sort table entries in alphabetical, numeric, or date order. You can
also total a row or column of numbers in a table, as well as perform other calculations,
such as averaging.

Using tables to create page layouts
You can use tables to create page layouts, such as side-by-side paragraphs in a
résumé, or to create text, graphics, and nested tables on a Web page.
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About animating text
To add visual interest or emphasis to a document, you can animate text. Microsoft
Word comes with a number of built-in text animations, such as Sparkle Text.
Text animations are most effective in documents that will be displayed on-screen,
because in a printed document, the animations appear as regular text. For example,
animating the title of an e-mail memo would be effective, but animating the headings for
a printed report would be less so.
To view your text animations on a Web page, you must first save your document in
Word document format, and then create a hyperlink from the Web page to the
document. If you save the document as a Web page and then open it in a browser,
animated text effects won't appear.
Because animated text might distract readers, it's best to use it sparingly. You can
remove animation from text yourself; readers who do not want to view the animated
text in your document also can hide text animation.

Remove animation from text:
1. Select the text you want to remove animation from.
2. On the Format menu, click Font, and then click the Text Effects tab.
3. In the Animations box, click none.
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FONT WINDOWS:

Microsoft Word 2000 includes an extensive set of automatic features that makes
everyday tasks easier.
This topic provides reference information about:

AutoCorrect
You can use the AutoCorrect feature to detect and correct typos, misspelled words,
grammatical errors, and incorrect capitalization. Word comes with a list of built-in
corrections (called AutoCorrect entries), but you can easily add or remove entries.

17

AutoCorrect now has more power to detect and correct common spelling errors. This is
because AutoCorrect now uses the spelling checker's main dictionary rather than a
predefined list of spelling corrections.
You can maintain a separate list of AutoCorrect entries for each language. Word will
switch to the appropriate list based on the language formatting in the document. To
obtain the AutoCorrect list for a specific language, you might need to obtain the
Microsoft Proofing Tools Kit.
You can use the AutoCorrect exceptions list to prevent unwanted spelling corrections.

AutoFormat As You Type
Word can format text automatically as you type. Learn about formatting a document as
you type.
Word automates the lead-in emphasis — that is, detects the formatting applied in the
first list item and applies it to the next item. For example:
1. Word 2000 is smart! It does the work for you.
2. Word 2000 is cool! It makes your document look amazing.
Word translates common typing patterns to richer formatting — for example, Word
changes *Bold* to Bold, and _Underline_ to Underline.
When you type +----+----+, Word creates a table with a column for each pair of +
signs.
Word detects leading spaces that correspond to the left margin of the bulleted or
numbered paragraph above and changes your left indentation for you.

AutoComplete
Word can automatically offer suggestions for the rest of the word or phrase you are
typing, including dates and AutoText entries. Learn about quickly inserting an entire
item by typing a few characters.
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AutoSummarize
You can use the AutoSummarize feature to automatically summarize the key points
in a document. Word analyzes your document statistically and linguistically to
determine the most important sentences and gives you a custom summary based on
this analysis. By using AutoSummarize, you can highlight the key points in an online
document and view those points at different levels of detail. You can also automatically
create a separate summary or abstract of any length. Learn about automatically
summarizing a document.

Automatic style creation and style preview
Word 2000 includes several style improvements. Learn more about formatting text by
using styles.


It automatically creates a style for you when you apply new formatting to your
text.



It can automatically redefine styles to reflect your recently applied changes.



It gives you an instant preview of each style from the Style list on the Formatting
toolbar.

Letter Wizard
The Letter Wizard in Word 2000 can help you write a new letter quickly and easily, or
it can help you change and add to elements in your existing letter. The Letter Wizard
includes:
Letter Wizard dialog box Accessible from the Tools menu, this dialog box provides
letter element choices to help you create your letter. If you've already started a letter,
this dialog box displays the appropriate information from your letter so that you get an
instant snapshot of what you have and what you need. In addition, Word remembers
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the persons you've sent letters to and stores all related information, such as contact
names, addresses, and titles, in a list. When you send a letter to a previous recipient,
all you have to do is select that person's name from a list, and Word automatically fills
in the rest of the information for you.

Step-by-step Help through the Office Assistant
When you type a common letter opening, such as "Dear Joe," Word recognizes the
text as a letter opening and immediately offers to step you through the letter creation
process by using the Office Assistant. The Office Assistant is fully integrated with the
Letter Wizard dialog box and provides hints and details on all the letter elements.

Easy text reuse
After you use the Letter Wizard, Word automatically adds structure and styles to your
letter by converting letter elements into AutoText List fields. For example, the closing
text "Sincerely" is converted to a Closing field. When you right-click the word
"Sincerely," a menu appears that offer alternative closings, such as "Best regards" and
"Cordially." You can easily replace "Sincerely" with any of these letter closings by
clicking the closing you want. Learn about how to create letters.

End of Ms Word
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